
Chapter 11

Poisson Regression

If the response variable Y is a count, then the Poisson regression model is
often useful. For example, counts often occur in wildlife studies where a
region is divided into subregions and Yi is the number of a specified type of
animal found in the subregion. The following definition makes simulation of
Poisson regression data simple. See Section 1.3.

11.1 Poisson Regression

Definition 11.1. The Poisson regression model states that Y1, ..., Yn are
independent random variables with

Yi ∼ Poisson(µ(xi)).

The loglinear Poisson regression (LLR) model is the special case where

µ(xi) = exp(α + βTxi). (11.1)

Model (11.1) can be written compactly as Y |SP ∼ Poisson(exp(SP)). No-
tice that the conditional mean and variance functions are equal: E(Y |SP ) =
V (Y |SP ) = exp(SP ). For the LLR model, the Y are independent and

Y ≈ Poisson(exp(ESP)),

or Y |SP ≈ Y |ESP ≈ Poisson(µ̂(ESP)). For example, Y |(SP = 0) ∼
Poisson(1), and Y |(ESP = 0) ≈ Poisson(1).
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In the response plot for loglinear regression, the shape of the estimated
mean function µ̂(ESP ) = exp(ESP ) depends strongly on the range of the
ESP. The variety of shapes occurs because the plotting software attempts
to fill the vertical axis. Hence the range of the ESP is narrow, then the
exponential function will be rather flat. If the range of the ESP is wide, then
the exponential curve will look flat in the left of the plot but will increase
sharply in the right of the plot.

Definition 11.2. The estimated sufficient summary plot (ESSP) or re-

sponse plot, is a plot of the ESP = α̂ + β̂
T
xi versus Yi with the estimated

mean function
µ̂(ESP ) = exp(ESP )

added as a visual aid. A scatterplot smoother such as lowess is also added
as a visual aid.

This plot is very useful as a goodness of fit diagnostic. The lowess curve
is a nonparametric estimator of the mean function and is represented as a
jagged curve to distinguish it from the estimated LLR mean function (the
exponential curve) in Figure 1.9. If the number of predictors k < n/10, if
there is no overdispersion, and if the lowess curve follows the exponential
curve closely (except possibly for the largest values of the ESP), then the
LLR mean function may be a useful approximation for E(Y |x). A useful
lack of fit plot is a plot of the ESP versus the deviance residuals that are
often available from the software.

The deviance test described in Section 11.2 is used to test whether β = 0,
and is the analog of the ANOVA F test for multiple linear regression. If
the LLR model is a good approximation to the data but β = 0, then the
predictors x are not needed in the model and µ̂(xi) ≡ µ̂ = Y (the sample
mean) should be used instead of the LLR estimator

µ̂(xi) = exp(α̂ + β̂
T
xi).

If the exponential curve clearly fits the lowess curve better than the line
Y = Y , then Ho should be rejected, but if the line Y = Y fits the lowess
curve about as well as the exponential curve (which should only happen if the
exponential curve is approximately linear with a small slope), then Y may
be independent of the predictors. Figure 1.10 shows the ESSP when only X4

and X5 are used as predictors for the artificial data, and Y is independent of
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these two predictors by construction. It is possible to find data sets that look
like Figure 1.10 where the p–value for the deviance test is very small. Then
the LLR relationship is statistically significant, but the investigator needs to
decide whether the relationship is practically significant.

Warning: For many count data sets where the LLR mean function
is correct, the LLR model is not appropriate but the LLR MLE is still a
consistent estimator of β. The problem is that for many data sets where
E(Y |x) = µ(x) = exp(SP ), it turns out that V (Y |x) > exp(SP ). This phe-
nomenon is called overdispersion. Adding parametric and nonparametric
estimators of the standard deviation function to the response plot can be
useful. See Cook and Weisberg (1999a, p. 401-403). Alternatively, if the
response plot looks good and G2/(n − k − 1) ≈ 1, then the LLR model is
likely useful. Here the deviance G2 is described in Section 11.2.

A useful alternative to the LLR model is a negative binomial regression
(NBR) model. If Y has a (generalized) negative binomial distribution, Y ∼
NB(µ, κ), then the probability mass function of Y is

P (Y = y) =
Γ(y + κ)

Γ(κ)Γ(y + 1)

(
κ

µ + κ

)κ (
1 − κ

µ + κ

)y

for y = 0, 1, 2, ... where µ > 0 and κ > 0. Then E(Y ) = µ and V(Y ) =
µ+µ2/κ. (This distribution is a generalization of the negative binomial (κ, ρ)
distribution with ρ = κ/(µ + κ) and κ > 0 is an unknown real parameter
rather than a known integer.)

Definition 11.3. The negative binomial regression (NBR) model
states that Y1, ..., Yn are independent random variables where

Yi ∼ NB(µ(xi), κ)

with µ(xi) = exp(α + βT xi). Hence Y |SP ∼ NB(exp(SP), κ), E(Y |SP ) =
exp(SP ) and

V (Y |SP ) = exp(SP )

(
1 +

exp(SP )

κ

)
.

The NBR model has the same mean function as the LLR model but allows
for overdispersion. As κ → ∞, the NBR model converges to the LLR model.
Since the Poisson regression model is simpler than the NBR model, graphical
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diagnostics for the goodness of fit of the LLR model would be useful. The
following plot was suggested by Winkelmann (2000, p. 110).

Definition 11.4. To check for overdispersion, use the OD plot
of the estimated model variance V̂ (Y |SP ) versus the squared residuals V̂ =
[Y − Ê(Y |SP )]2. For the LLR model, V̂ (Y |SP ) = exp(ESP ) = Ê(Y |SP )
and V̂ = [Y − exp(ESP )]2.

Numerical summaries are also available. The deviance G2 is a statis-
tic used to assess the goodness of fit of the Poisson regression model much
as R2 is used for multiple linear regression. For Poisson regression, G2 is
approximately chi-square with n − p − 1 degrees of freedom. Since a χ2

d

random variable has mean d and standard deviation
√

2d, the 98th per-
centile of the χ2

d distribution is approximately d + 3
√

d ≈ d + 2.121
√

2d. If
G2 > (n− p− 1) + 3

√
n − p − 1, then a more complicated count model than

(11.1) may be needed. A good discussion of such count models is in Simonoff
(2003).

For model (11.1), Winkelmann (2000, p. 110) suggested that the plotted
points in the OD plot should scatter about the identity line through the
origin with unit slope and that the OLS line should be approximately equal
to the identity line if the LLR model is appropriate. But in simulations, it
was found that the following two observations make the OD plot much easier
to use for Poisson regression.

First, recall that a normal approximation is good for both the Poisson
and negative binomial distributions if the count Y is not too small. Notice
that if Y = E(Y |SP ) + 2

√
V (Y |SP ), then [Y − E(Y |SP )]2 = 4V (Y |SP ).

Hence if both the estimated mean and estimated variance functions are good
approximations, the plotted points in the OD plot for Poisson regression will
scatter about a wedge formed by the V̂ = 0 line and the line through the
origin with slope 4: V̂ = 4V̂ (Y |SP ). If the normal approximation is good,
only about 5% of the plotted points should be above this line.

Second, the evidence of overdispersion increases from slight to high as the
scale of the vertical axis increases from 5 to 10 times that of the horizontal
axis. (The scale of the vertical axis tends to depend on the few cases with
the largest V̂ (Y |SP ), and P [(Y − Ê(Y |SP ))2 > 10V̂ (Y |SP )] can be approx-
imated with a normal approximation or Chebyshev’s inequality.) There is
considerable evidence of overdispersion if the scale of the vertical axis is more
than 10 times that of the horizontal, or if the percentage of points above the
slope 4 line through the origin is much larger than 5%. Hence the identity
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line and slope 4 line are added to the OD plot as visual aids, and one should
check whether the scale of the vertical axis is more than 10 times that of the
horizontal.

Combining the response plot with the OD plot is a powerful method for
assessing the adequacy of the Poisson regression model. It is easier to use the
OD plot to check the variance function than the response plot since judging
the variance function with the straight lines of the OD plot is simpler than
judging two curves. Also outliers are often easier to spot with the OD plot.

For LLR Poisson regression, judging the mean function from the ESSP
may be rather difficult for large counts for two reasons. First, the mean func-
tion is curved. Secondly, for real and simulated Poisson regression data, it
was observed that scatterplot smoothers such as lowess tend to underestimate
the mean function for large ESP.

The basic idea of the following two plots for Poisson regression is to
transform the data towards a linear model, then make the response plot and
residual plot for the transformed data. The plots are based on weighted least
squares (WLS) regression. For the equivalent least squares (OLS) regression
without intercept of W on u, the ESSP is the (weighted fit) response plot
of Ŵ versus W . The mean function is the identity line and the vertical
deviations from the identity line are the WLS residuals W−Ŵ . Since P (Yi =
0) > 0, the estimators given in the following definition are useful. Let Zi = Yi

if Yi > 0, and let Zi = 0.5 if Yi = 0.

Definition 11.5. The minimum chi–square estimator of the param-
eters (α, β) in a loglinear regression model are (α̂M , β̂M ), and are found from
the weighted least squares regression of log(Zi) on xi with weights wi = Zi.
Equivalently, use the ordinary least squares (OLS) regression (without inter-
cept) of

√
Zi log(Zi) on

√
Zi(1, x

T
i )T .

The minimum chi–square estimator tends to be consistent if n is fixed
and all n counts Yi increase to ∞, while the loglinear regression maximum
likelihood estimator (α̂, β̂) tends to be consistent if the sample size n → ∞.
See Agresti (2002, p. 611-612). However, the two estimators are often close
for many data sets. Use the OLS regression (without intercept) of

√
Zi log(Zi)

on
√

Zi(1, x
T
i )T . Then the plot of the “fitted values”

√
Zi(α̂M + β̂

T

Mxi) versus
the “response”

√
Zi log(Zi) should have points that scatter about the identity

line. These results and the equivalence of the minimum chi–square estimator
to an OLS estimator suggest the following diagnostic plots.
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Definition 11.6. For a loglinear Poisson regression model, a weighted

fit response plot is a plot of
√

ZiESP =
√

Zi(α̂+β̂
T
xi) versus

√
Zi log(Zi).

The weighted residual plot is a plot of
√

Zi(α̂ + β̂
T
xi) versus the “WLS”

residuals rWi =
√

Zi log(Zi) −
√

Zi(α̂ + β̂
T
xi).

If the loglinear regression model is appropriate and the LLR estimator
is good, then the plotted points in the weighted fit response plot should
follow the identity line. When the counts Yi are small, the “WLS” residuals
can not be expected to be approximately normal. Often the larger counts
are fit better than the smaller counts and hence the residual plots have a
“left opening megaphone” shape. This fact makes residual plots for Poisson
regression rather hard to use, but cases with large “WLS” residuals may not
be fit very well by the model. Both the weighted fit response and residual
plots perform better for simulated LLR data with many large counts than
for data where all of the counts are less than 10.

Example 11.1. For the Ceriodaphnia data of Myers, Montgomery and
Vining (2002, p. 136-139), the response variable Y is the number of Ceri-
odaphnia organisms counted in a container. The sample size was n = 70
and seven concentrations of jet fuel (x1) and an indicator for two strains
of organism (x2) were used as predictors. The jet fuel was believed to im-
pair reproduction so high concentrations should have smaller counts. Figure
11.1 shows the 4 plots for this data. In the response plot of Figure 11.1a,
the lowess curve is represented as a jagged curve to distinguish it from the
estimated LLR mean function (the exponential curve). The horizontal line
corresponds to the sample mean Y .

The OD plot in Figure 11.1b suggests that there is little evidence of
overdispersion since the vertical scale is less than ten times that of the hor-
izontal scale and all but one of the plotted points are close to the wedge
formed by the horizontal axis and slope 4 line. The plotted points scatter
about the identity line in Figure 11.1c and there are no unusual points in
Figure 11.1d. The four plots suggest that the LLR Poisson regression model
is a useful approximation to the data. Hence Y |ESP ≈ Poisson(exp(ESP)).
For example, when ESP = 1.61, Y ≈ Poisson(5) and when ESP = 4.5, Y ≈
Poisson(90). Notice that the Poisson mean can be roughly estimated by
finding the height of the exponential curve in Figure 11.1a.
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Figure 11.1: Plots for Ceriodaphnia Data
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Figure 11.2: Plots for Crab Data
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Figure 11.3: Plots for Popcorn Data

Example 11.2. Agresti (2002, p. 126-131) uses Poisson regression for
data where the response Y is the number of satellites (male crabs) near a
female crab. The sample size n = 173 and the predictor variables were
the color (2: light medium, 3: medium, 4: dark medium, 5: dark), spine
condition (1: both good, 2: one worn or broken, 3 both worn or broken),
carapace width in cm and weight of the female crab in grams.

The model used to produce Figure 11.2 used the ordinal variables color
and spine condition as coded. An alternative model would use spine con-
dition as a factor. Figure 11.2a suggests that there is one case with an
unusually large value of the ESP. Notice that the lowess curve does not track
the exponential curve very well. Figure 11.2b suggests that overdispersion is
present since the vertical scale is about 10 times that of the horizontal scale
and too many of the plotted points are large and higher than the slope 4
line. The lack of fit may be clearer in Figure 11.2c since the plotted points
fail to cover the identity line. Although the exponential mean function fits
the lowess curve better than the line Y = Y , alternative models suggested
by Agresti (2002) may fit the data better.

Example 11.3. For the popcorn data of Myers, Montgomery and Vining
(2002, p. 154), the response variable Y is the number of inedible popcorn
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kernels. The sample size was n = 15 and the predictor variables were tem-
perature (coded as 5, 6 or 7), amount of oil (coded as 2, 3 or 4) and popping
time (75, 90 or 105). One batch of popcorn had more than twice as many
inedible kernels as any other batch and is an outlier that is easily detected
in all four plots in Figure 11.3. Ignoring the outlier in Figure 11.3a suggests
that the line Y = Y will fit the data and lowess curve better than the ex-
ponential curve. Hence Y seems to be independent of the predictors. Notice
that the outlier sticks out in Figure 11.3b and that the vertical scale is well
over 10 times that of the horizontal scale. If the outlier was not detected,
then the Poisson regression model would suggest that temperature and time
are important predictors, and overdispersion diagnostics such as the deviance
would be greatly inflated.

11.2 Inference

This section gives a brief discussion of inference for the loglinear Poisson
regression (LLR) model. Inference for this model is very similar to inference
for the multiple linear regression, survival regression and logistic regression
models. For all of these models, Y is independent of the k × 1 vector of
predictors x = (x1, ..., xk)

T given the sufficient predictor α + βTx:

Y x|(α + βTx).

To perform inference for LLR, computer output is needed. The computer
output looks nearly identical to that needed for logistic regression.

Point estimators for the mean function are important. Given values of
x = (x1, ..., xk)

T , a major goal of loglinear regression is to estimate the mean
E(Y |x) = µ(x) with the estimator

µ̂(x) = exp(α̂ + β̂
T
x). (11.2)

Investigators also sometimes test whether a predictor Xj is needed in the
model given that the other k − 1 nontrivial predictors are in the model with
a 4 step Wald test of hypotheses:
i) State the hypotheses Ho: βj = 0 Ha: βj �= 0.

ii) Find the test statistic zo,j = β̂j/se(β̂j) or obtain it from output.
iii) The p–value = 2P (Z < −|zoj|) = 2P (Z > |zoj|). Find the p–value from
output or use the standard normal table.
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iv) State whether you reject Ho or fail to reject Ho and give a nontechnical
sentence restating your conclusion in terms of the story problem.

If Ho is rejected, then conclude that Xj is needed in the LLR model for
Y given that the other k− 1 predictors are in the model. If you fail to reject
Ho, then conclude that Xj is not needed in the LLR model for Y given that
the other k − 1 predictors are in the model. Note that Xj could be a very
useful LLR predictor, but may not be needed if other predictors are added
to the model.

The Wald confidence interval (CI) for βj can also be obtained from the

output: the large sample 100 (1 − δ) % CI for βj is β̂j ± z1−δ/2 se(β̂j).

The Wald test and CI tend to give good results if the sample size n
is large. Here 1 − δ refers to the coverage of the CI. Recall that a 90%
CI uses z1−δ/2 = 1.645, a 95% CI uses z1−δ/2 = 1.96, and a 99% CI uses
z1−δ/2 = 2.576.

For a LLR, often 3 models are of interest: the full model that uses all k of
the predictors xT = (xT

R, xT
O), the reduced model that uses the r predictors

xR, and the saturated model that uses n parameters θ1, ..., θn where n is
the sample size. For the full model the k + 1 parameters α, β1, ..., βk are
estimated while the reduced model has r +1 parameters. Let lSAT (θ1, ..., θn)
be the likelihood function for the saturated model and let lFULL(α, β) be the
likelihood function for the full model. Let

LSAT = log lSAT (θ̂1, ..., θ̂n)

be the log likelihood function for the saturated model evaluated at the max-
imum likelihood estimator (MLE) (θ̂1, ..., θ̂n) and let

LFULL = log lFULL(α̂, β̂)

be the log likelihood function for the full model evaluated at the MLE (α̂, β̂).
Then the deviance

D = G2 = −2(LFULL − LSAT ).

The degrees of freedom for the deviance = dfFULL = n − k − 1 where n is
the number of parameters for the saturated model and k + 1 is the number
of parameters for the full model.
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The saturated model for loglinear regression states that Y1, ..., Yn are in-
dependent Poisson(µi) random variables where µ̂i = Yi. The saturated model
is usually not very good for Poisson data, but the saturated model may be
good if n is fixed and all of the counts Yi are large.

If X ∼ χ2
d then E(X) = d and VAR(X) = 2d. An observed value of

x > d + 3
√

d is unusually large and an observed value of x < d − 3
√

d is
unusually small.

When the saturated model is good, a rule of thumb is that the loglinear
regression model is ok if G2 ≤ n−k−1 (or if G2 ≤ n−k−1+3

√
n − k − 1).

The χ2
n−k+1 approximation for G2 may not be good even for large sample sizes

n. For LLR, the response and OD plots and G2 ≤ n − k − 1 + 3
√

n − k − 1
should be checked.

The Arc output below, shown in symbols and for a real data set, is used
for the deviance test described after the output. Assume that the estimated
sufficient summary plot has been made and that the loglinear regression
model fits the data well in that the lowess estimated mean function follows
the estimated model mean function closely. The deviance test is used to test
whether β = 0. If this is the case, then the predictors are not needed in the
LLR model. If Ho : β = 0 is not rejected, then for loglinear regression the
estimator µ̂ = Y should be used.

Response = Y
Terms = (X1, ..., Xk)
Sequential Analysis of Deviance

Total Change
Predictor df Deviance df Deviance

Ones n − 1 = dfo G2
o

X1 n − 2 1
X2 n − 3 1
...

...
...

...
Xk n − k − 1 = dfFULL G2

FULL 1

The 4 step deviance test follows.
i) Ho : β = 0 HA : β �= 0
ii) test statistic G2(o|F ) = G2

o − G2
FULL

iii) The p–value = P (χ2 > G2(o|F )) where χ2 ∼ χ2
k has a chi–square
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distribution with k degrees of freedom. Note that k = k + 1 − 1 = dfo −
dfFULL = n − 1 − (n − k − 1).

iv) Reject Ho if the p–value < δ and conclude that there is a LLR rela-
tionship between Y and the predictors X1, ..., Xk. If p–value ≥ δ, then fail
to reject Ho and conclude that there is not a LLR relationship between Y
and the predictors X1, ..., Xk.

The output shown on the following page, both in symbols and for a real
data set, can be used to perform the change in deviance test. If the re-
duced model leaves out a single variable Xi, then the change in deviance
test becomes Ho : βi = 0 versus HA : βi �= 0. This likelihood ratio test is a
competitor of the Wald test. The likelihood ratio test is usually better than
the Wald test if the sample size n is not large, but the Wald test is currently
easier for software to produce. For large n the test statistics from the two
tests tend to be very similar (asymptotically equivalent tests).

Response = Y Terms = (X1, ..., Xk) (Full Model)

Label Estimate Std. Error Est/SE p-value
Constant α̂ se(α̂) zo,0 for Ho: α = 0

x1 β̂1 se(β̂1) zo,1 = β̂1/se(β̂1) for Ho: β1 = 0
...

...
...

...
...

xk β̂k se(β̂k) zo,k = β̂k/se(β̂k) for Ho: βk = 0
Degrees of freedom: n - k - 1 = dfFULL

Deviance: D = G2
FULL

Response = Y Terms = (X1, ..., Xr) (Reduced Model)

Label Estimate Std. Error Est/SE p-value
Constant α̂ se(α̂) zo,0 for Ho: α = 0

x1 β̂1 se(β̂1) zo,1 = β̂1/se(β̂1) for Ho: β1 = 0
...

...
...

...
...

xr β̂r se(β̂r) zo,r = β̂k/se(β̂r) for Ho: βr = 0
Degrees of freedom: n - r - 1 = dfRED

Deviance: D = G2
RED

If the reduced model is good, then the EE plot of ESP (R) = α̂R+β̂
T

RxRi

versus ESP = α̂ + β̂
T
xi should be highly correlated with the identity line
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with unit slope and zero intercept.

After obtaining an acceptable full model where

SP = α + β1x1 + · · · + βkxk = α + βTx = α + βT
RxR + βT

OxO

try to obtain a reduced model

SP = αR + βR1xR1 + · · · + βRrxRr = αR + βT
RxR

where the reduced model uses r of the predictors used by the full model and
xO denotes the vector of k − r predictors that are in the full model but not
the reduced model. For loglinear regression the reduced model is Yi|xRi ∼
independent Poisson(exp(βT

RxRi)) for i = 1, ..., n.

Assume that the full model looks good (so the response and OD plots
look good). Then we want to test Ho: the reduced model is good (can be
used instead of the full model) versus HA: use the full model (the full model
is significantly better than the reduced model). Fit the full model and the
reduced model to get the deviances G2

FULL and G2
RED.

The 4 step change in deviance test follows.
i) Ho: the reduced model is good HA: use the full model
ii) test statistic G2(R|F ) = G2

RED − G2
FULL

iii) The p–value = P (χ2 > G2(R|F )) where χ2 ∼ χ2
k−r has a chi–square

distribution with k degrees of freedom. Note that k is the number of non-
trivial predictors in the full model while r is the number of nontrivial pre-
dictors in the reduced model. Also notice that k − r = (k + 1) − (r + 1) =
dfRED − dfFULL = n − r − 1 − (n − k − 1).

iv) Reject Ho if the p–value < δ and conclude that the full model should
be used. If p–value ≥ δ, then fail to reject Ho and conclude that the reduced
model is good.

Interpretation of coefficients: if x1, ..., xi−1, xi+1, ..., xk can be held fixed,
then increasing xi by 1 unit increases the sufficient predictor SP by βi units.
In loglinear Poisson regression, increasing a predictor xi by 1 unit (while
holding all other predictors fixed) multiplies the estimated mean function by
a factor of exp(β̂i).
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Label Estimate Std. Error Est/SE p-value

Constant -0.406023 0.877382 -0.463 0.6435

bombload 0.165425 0.0675296 2.450 0.0143

exper -0.0135223 0.00827920 -1.633 0.1024

type 0.568773 0.504297 1.128 0.2594

Example 11.4. Use the above output to perform inference on the num-
ber of locations where aircraft was damaged. The output is from a loglinear
regression. The variable exper = total months of aircrew experience while
type of aircraft was coded as 0 or 1. There were n = 30 cases. Data is from
Montgomery, Peck and Vining (2001).

a) Predict µ̂(x) if bombload = x1 = 7.0, exper = x2 = 80.2 and type
= x3 = 1.0.

b) Perform the 4 step Wald test for Ho : β2 = 0.

c) Find a 95% confidence interval for β3.

Solution: a) ESP = α̂+ β̂1x1 + β̂2x2 + β̂3x3 = −0.406023+0.165426(7)−
0.0135223(80.2)+0.568773(1) = 0.2362. So µ̂(x) = exp(ESP ) = exp(0.2360) =
1.2665.

b) i) Ho β2 = 0 HA β2 �= 0
ii) t02 = −1.633.
iii) pval = 0.1024
iv) Fail to reject Ho, exper in not needed in the LLR model for number

of locations given that bombload and type are in the model.
c) β̂3 ± 1.96SE(β̂3) = 0.568773 ± 1.96(0.504297) = 0.568773 ± 0.9884 =

(−0.4196, 1.5572).

11.3 Variable Selection

This section gives some rules of thumb for variable selection for loglinear
Poisson regression. Before performing variable selection, a useful full model
needs to be found. The process of finding a useful full model is an iterative
process. Given a predictor x, sometimes x is not used by itself in the full
model.

The full model will often contain factors and interaction. If w is a nominal
variable with J levels, make w into a factor by using use J − 1 (indicator or)
dummy variables x1,w, ..., xJ−1,w in the full model. For example, let xi,w = 1 if
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w is at its ith level, and let xi,w = 0, otherwise. An interaction is a product
of two or more predictor variables. Interactions are difficult to interpret.
Often interactions are included in the full model, and then the reduced model
without any interactions is tested. The investigator is often hoping that the
interactions are not needed.

A scatterplot of x versus Y is used to visualize the conditional distri-
bution of Y |x. A scatterplot matrix is an array of scatterplots and is used
to examine the marginal relationships of the predictors and response. Place
Y on the top or bottom of the scatterplot matrix. Variables with outliers,
missing values or strong nonlinearities may be so bad that they should not be
included in the full model. Suppose that all values of the variable x are posi-
tive. The log rule says add log(x) to the full model if max(xi)/min(xi) > 10.

To make a full model, use the above discussion and then make the re-
sponse and OD plots to check that the full model is good. The number of
predictors in the full model should be much smaller than the number of data
cases n. For loglinear regression, a rough rule of thumb is that the full model
should use no more than n/5 predictors and the final submodel should use
no more than n/10 predictors.

Variable selection, also called subset or model selection, is the search for
a subset of predictor variables that can be deleted without important loss of
information. A model for variable selection for LLR can be described by

SP = α + βTx = α + βT
SxS + βT

ExE = α + βT
SxS (11.3)

where x = (xT
S , xT

E)T is a k× 1 vector of nontrivial predictors, xS is a rS × 1
vector and xE is a (k − rS) × 1 vector. Given that xS is in the model,
βE = 0 and E denotes the subset of terms that can be eliminated given that
the subset S is in the model.

Since S is unknown, candidate subsets will be examined. Let xI be the
vector of r terms from a candidate subset indexed by I , and let xO be the
vector of the remaining terms (out of the candidate submodel). Then

SP = α + βT
I xI + βT

OxO. (11.4)
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Definition 11.7. The model with SP = α + βTx that uses all of the
predictors is called the full model. A model with SP = α + βT

I xI that only
uses the constant and a subset xI of the nontrivial predictors is called a
submodel. The full model is always a submodel.

Suppose that S is a subset of I and that model (11.3) holds. Then

SP = α + βT
SxS = α + βT

SxS + βT
(I/S)xI/S + 0T xO = α + βT

I xI (11.5)

where xI/S denotes the predictors in I that are not in S. Since this is true
regardless of the values of the predictors, βO = 0 if the set of predictors S is
a subset of I. Let (α̂, β̂) and (α̂I , β̂I) be the estimates of (α, β) obtained from
fitting the full model and the submodel, respectively. Denote the ESP from

the full model by ESP = α̂ + β̂
T
xi and denote the ESP from the submodel

by ESP (I) = α̂I + β̂IxIi.

Definition 11.8. An EE plot is a plot of ESP (I) versus ESP .

Variable selection is closely related to the change in deviance test for
a reduced model. You are seeking a subset I of the variables to keep in
the model. The AIC(I) statistic is used as an aid in backward elimination
and forward selection. The full model and the model Imin found with the
smallest AIC are always of interest. Burnham and Anderson (2004) suggest
that if ∆(I) = AIC(I)− AIC(Imin), then models with ∆(I) ≤ 2 are good,
models with 4 ≤ ∆(I) ≤ 7 are borderline, and models with ∆(I) > 10 should
not be used as the final submodel. Create a full model. The full model has
a deviance at least as small as that of any submodel. The final submodel
should have an EE plot that clusters tightly about the identity line. As a
rough rule of thumb, a good submodel I has corr(ESP (I), ESP ) ≥ 0.95.
Look at the submodel II with the smallest number of predictors such that
∆(II) ≤ 2, and also examine submodels I with fewer predictors than II with
∆(I) ≤ 7. Model II is a good initial submodel to examine.

Backward elimination starts with the full model with k nontrivial vari-
ables, and the predictor that optimizes some criterion is deleted. Then there
are k − 1 variables left, and the predictor that optimizes some criterion is
deleted. This process continues for models with k − 2, k − 3, ..., 3 and 2
predictors.

Forward selection starts with the model with 0 variables, and the pre-
dictor that optimizes some criterion is added. Then there is 1 variable in
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the model, and the predictor that optimizes some criterion is added. This
process continues for models with 2, 3, ..., k − 1 and k predictors. Both for-
ward selection and backward elimination result in a sequence of k models
{x∗

1}, {x∗
1, x

∗
2}, ..., {x∗

1, x
∗
2, ..., x

∗
k−1}, {x∗

1, x
∗
2, ..., x

∗
k} = full model. The two se-

quences found by forward selection and backward elimination need not be
the same.

All subsets variable selection can be performed with the following
procedure. Compute the LLR ESP and the OLS ESP found by the OLS
regression of Y on x. Check that |corr(LLR ESP, OLS ESP)| ≥ 0.95. This
high correlation will exist for many data sets. Then perform multiple linear
regression and the corresponding all subsets OLS variable selection with the
Cp(I) criterion. If the sample size n is large and Cp(I) ≤ 2(r + 1) where the
subset I has r + 1 variables including a constant, then corr(OLS ESP, OLS
ESP(I)) will be high by the proof of Proposition 3.2, and hence corr(LLR
ESP, LLR ESP(I)) will be high. In other words, if the OLS ESP and LLR
ESP are highly correlated, then performing multiple linear regression and
the corresponding MLR variable selection (eg forward selection, backward
elimination or all subsets selection) based on the Cp(I) criterion may provide
many interesting submodels.

Know how to find good models from output. The following rules of thumb
(roughly in order of decreasing importance) may be useful. It is often not
possible to have all 10 rules of thumb to hold simultaneously. Let submodel I
have rI +1 predictors, including a constant. Do not use more predictors than
submodel II , which has no more predictors than the minimum AIC model.
It is possible that II = Imin = Ifull. Then the submodel I is good if
i) the response plot for the submodel looks like the response plot for the full
model.
ii) Want corr(ESP,ESP(I)) ≥ 0.95.
iii) The plotted points in the EE plot cluster tightly about the identity line.
iv) Want the p-value ≥ 0.01 for the change in deviance test that uses I as
the reduced model.
v) Want rI + 1 ≤ n/10.
vi) Want the deviance G2(I) close to G2(full) (see iv): G2(I) ≥ G2(full)
since adding predictors to I does not increase the deviance).
vii) Want AIC(I) ≤ AIC(Imin) + 7 where Imin is the minimum AIC model
found by the variable selection procedure.
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viii) Want hardly any predictors with p-values > 0.05.
ix) Want few predictors with p-values between 0.01 and 0.05.
x) Want G2(I) ≤ n − rI − 1 + 3

√
n − rI − 1.

Heuristically, backward elimination tries to delete the variable that will
increase the deviance the least. An increase in deviance greater than 4 (if the
predictor has 1 degree of freedom) may be troubling in that a good predictor
may have been deleted. In practice, the backward elimination program may
delete the variable such that the submodel I with j predictors has a) the
smallest AIC(I), b) the smallest deviance G2(I) or c) the biggest p–value
(preferably from a change in deviance test but possibly from a Wald test)
in the test Ho βi = 0 versus HA βi �= 0 where the model with j + 1 terms
from the previous step (using the j predictors in I and the variable x∗

j+1) is
treated as the full model.

Heuristically, forward selection tries to add the variable that will decrease
the deviance the most. A decrease in deviance less than 4 (if the predictor has
1 degree of freedom) may be troubling in that a bad predictor may have been
added. In practice, the forward selection program may add the variable such
that the submodel I with j nontrivial predictors has a) the smallest AIC(I),
b) the smallest deviance G2(I) or c) the smallest p–value (preferably from a
change in deviance test but possibly from a Wald test) in the test Ho βi = 0
versus HA βi �= 0 where the current model with j terms plus the predictor
xi is treated as the full model (for all variables xi not yet in the model).

Suppose that the full model is good and is stored in M1. Let M2, M3,
M4 and M5 be candidate submodels found after forward selection, backward
elimination, etc. Make a scatterplot matrix of the ESPs for M2, M3, M4, M5
and M1. Good candidates should have estimated sufficient predictors that
are highly correlated with the full model estimated sufficient predictor (the
correlation should be at least 0.9 and preferably greater than 0.95).

The final submodel should have few predictors, few variables with large
Wald p–values (0.01 to 0.05 is borderline), good response and OD plots, and
an EE plot that clusters tightly about the identity line. If a factor has I − 1
dummy variables, either keep all I − 1 dummy variables or delete all I − 1
dummy variables, do not delete some of the dummy variables.
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P1 P2 P3 P4
df 144 147 148 149

# of predictors 6 3 2 1
# with 0.01 ≤ Wald p-value ≤ 0.05 1 0 0 0

# with Wald p-value > 0.05 3 0 1 0
G2 127.506 131.644 147.151 149.861
AIC 141.506 139.604 153.151 153.861

corr(P1:ETA’U,Pi:ETA’U) 1.0 0.954 0.810 0.792
p-value for change in deviance test 1.0 0.247 0.0006 0.0

Example 11.5. The above table gives summary statistics for 4 models
considered as final submodels after performing variable selection. Poisson
loglinear regression was used. The response plot for the full model P1 was
good. Model P2 was the minimum AIC model found.

Which model is the best candidate for the final submodel? Explain briefly
why each of the other 3 submodels should not be used.

Solution: P2 is best. P1 has too many predictors with large pvalues and
more predictors than the minimum AIC model. P3 and P4 have corr and
pvalue too low and AIC too high.

11.4 Complements

Cameron and Trivedi (1998), Long (1997) and Winkelmann (2008) cover
Poisson regression. Also see Hilbe (2007) and texts on categorical data anal-
ysis and generalized linear models.

The response plot is essential for understanding the loglinear Poisson
regression model and for checking goodness and lack of fit if the estimated

sufficient predictor α̂ + β̂
T
x takes on many values. The response plot and

OD plot are examined in Olive (2009e). Goodness of fit is also discussed
by Cheng and Wu (1994), Kauermann and Tutz (2001), Pierce and Schafer
(1986), Spinelli, Lockart and Stephens (2002), Su and Wei (1991).

For Poisson regression, the OD plot can be used to complement tests and
diagnostics for overdispersion such as those given in Breslow (1990), Cameron
and Trevedi (1998), Dean (1992), Ganio and Schafer (1992), Lambert and
Roeder (1995), and Winkelmann (2008).

The same 4 plots for LLR Poisson regression can be used for NBR, but
the OD plot should use V̂ (Y |SP ) = exp(ESP )(1 + exp(ESP )/κ̂) on the
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horizontal axis. As overdispersion increases, larger sample sizes are needed
for the OD plot. The weighted fit response plot will be linear but the weights
wi = Zi will be suboptimal. For Example 11.2, the WFRP will again look
like Figure 11.2c, suggesting that the NBR model is not appropriate.

Olive and Hawkins (2005) give the simple all subsets variable selection
procedure that can be applied to Poisson regression using readily available
OLS software. The procedures of Lawless and Singhai (1978) and Nordberg
(1982) are much more complicated. Variable selection using the AIC criterion
is discussed in Burnham and Anderson (2004), Cook and Weisberg (1999)
and Hastie (1987).

Results from Cameron and Trivedi (1998, p. 89) suggest that if a loglinear
Poisson regression model is fit using OLS software for MLR, then a rough
approximation is β̂LLR ≈ β̂OLS/Y . So a rough approximation is LLR ESP
≈ (OLS ESP)/Y .

To motivate the weighted fit response plot and weighted residual plot,
assume that all n of the counts Yi are large. Then

log(µ(xi)) = log(µ(xi)) + log(Yi) − log(Yi) = α + βTxi,

or
log(Yi) = α + βT xi + ei

where

ei = log

(
Yi

µ(xi)

)
.

The error ei does not have zero mean or constant variance, but if µ(xi) is
large

Yi − µ(xi)√
µ(xi)

≈ N(0, 1)

by the central limit theorem. Recall that log(1 + x) ≈ x for |x| < 0.1. Then,
heuristically,

ei = log

(
µ(xi) + Yi − µ(xi)

µ(xi)

)
≈ Yi − µ(xi)

µ(xi)
≈

1√
µ(xi)

Yi − µ(xi)√
µ(xi)

≈ N

(
0,

1

µ(xi)

)
.

This suggests that for large µ(xi), the errors ei are approximately 0 mean
with variance 1/µ(xi). If the µ(xi) were known, and all of the Yi were large,
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then a weighted least squares of log(Yi) on xi with weights wi = µ(xi) should
produce good estimates of (α, β). Since the µ(xi) are unknown, the estimated
weights wi = Yi could be used.

11.5 Problems

The following three problems use the possums data from Cook and Weisberg
(1999a).

Output for Problem 11.1

Data set = Possums, Response = possums

Terms = (Habitat Stags)

Coefficient Estimates

Label Estimate Std. Error Est/SE p-value

Constant -0.652653 0.195148 -3.344 0.0008

Habitat 0.114756 0.0303273 3.784 0.0002

Stags 0.0327213 0.00935883 3.496 0.0005

Number of cases: 151

Degrees of freedom: 148

Pearson X2: 110.187

Deviance: 138.685

11.1∗. Use the above output to perform inference on the number of
possums in a given tract of land. The output is from a loglinear regression.

a) Predict µ̂(x) if habitat = x1 = 5.8 and stags = x2 = 8.2.

b) Perform the 4 step Wald test for Ho : β1 = 0.

c) Find a 95% confidence interval for β2.

Output for Problem 11.2

Response = possums Terms = (Habitat Stags)

Total Change

Predictor df Deviance | df Deviance

Ones 150 187.490 |

Habitat 149 149.861 | 1 37.6289

Stags 148 138.685 | 1 11.1759
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11.2∗. Perform the 4 step deviance test for the same model as in Problem
11.1 using the output above.

Output for Problem 11.3

Terms = (Acacia Bark Habitat Shrubs Stags Stumps)

Label Estimate Std. Error Est/SE p-value

Constant -1.04276 0.247944 -4.206 0.0000

Acacia 0.0165563 0.0102718 1.612 0.1070

Bark 0.0361153 0.0140043 2.579 0.0099

Habitat 0.0761735 0.0374931 2.032 0.0422

Shrubs 0.0145090 0.0205302 0.707 0.4797

Stags 0.0325441 0.0102957 3.161 0.0016

Stumps -0.390753 0.286565 -1.364 0.1727

Number of cases: 151

Degrees of freedom: 144

Deviance: 127.506

11.3∗. Let the reduced model be as in Problem 11.1 and use the output
for the full model be shown above. Perform a 4 step change in deviance test.

Arc Problems

The following two problems use data sets from Cook and Weisberg (1999a).

11.4∗. a) Activate possums.lsp in Arc with the menu commands
“File > Load > Data > Arcg > possums.lsp.” Scroll up the screen to read
the data description.

From Graph&Fit select Fit Poisson response. Select y as the response
and select Acacia, bark, habitat, shrubs, stags and stumps as the predictors.
Include the output in Word. This is your full model

b) (Response plot): From Graph&Fit select Plot of. Select P1:Eta’U for
the H box and y for the V box. From the OLS popup menu select Poisson
and move the slider bar to 1. Move the lowess slider bar until the lowess
curve tracks the exponential curve well. Include the response plot in Word.

c) From Graph&Fit select Fit Poisson response. Select y as the response
and select bark, habitat, stags and stumps as the predictors. Include the
output in Word.
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d) (Response plot): From Graph&Fit select Plot of. Select P2:Eta’U for
the H box and y for the V box. From the OLS popup menu select Poisson
and move the slider bar to 1. Move the lowess slider bar until the lowess
curve tracks the exponential curve well. Include the response plot in Word.

e) Deviance test. From the P2 menu, select Examine submodels and click
on OK. Include the output in Word and perform the 4 step deviance test.

f) Perform the 4 step change of deviance test.

g) EE plot. From Graph&Fit select Plot of. Select P2:Eta’U for the H
box and P1:Eta’U for the V box. Move the OLS slider bar to 1. Click on
the Options popup menu and type “y=x”. Include the plot in Word. Is the
plot linear?

11.5∗. In this problem you will find a good submodel for the possums
data.

a) Activate possums.lsp in Arc with the menu commands
“File > Load > Data > Arcg> possums.lsp.” Scroll up the screen to read
the data description.

b) From Graph&Fit select Fit Poisson response. Select y as the response
and select Acacia, bark, habitat, shrubs, stags and stumps as the predictors.

In Problem 11.4, you showed that this was a good full model.

c) Using what you have learned in class find a good submodel and include
the relevant output in Word.

(Hints: Create a full model. The full model has a deviance at least
as small as that of any submodel. Consider forward selection and backward
elimination. For each method, find the submodel Imin with the smallest AIC.
Let ∆(I) = AIC(I) − AIC(Imin), and find submodel II with the smallest
number of predictors such that ∆(II) ≤ 2, and also examine submodels I
with fewer predictors than II that have ∆(I) ≤ 7. The final submodel should
have an EE plot that clusters tightly about the identity line. As a rough rule
of thumb, a good submodel I has corr(ESP (I), ESP ) ≥ 0.95. Submodel
II is your initial candidate model. Fit this candidate model and look at the
Wald test p–values. Try to eliminate predictors with large p–values but make
sure that the deviance does not increase too much. You may have several
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models, say P2, P3, P4 and P5 to look at. Make a scatterplot matrix of the
Pi:ETA’U from these models and from the full model P1. Make the EE and
response plots for each model. The correlation in the EE plot should be at
least 0.9 and preferably greater than 0.95. As a very rough guide for Poisson
regression, the number of predictors in the full model should be less than
n/5 and the number of predictors in the final submodel should be less than
n/10. WARNING: do not delete part of a factor. Either keep all J −1 factor
dummy variables or delete all J − 1 factor dummy variables. WARNING: if
an important factor is in the full model but not the reduced model, then the
plotted points in the EE plot may follow more than 1 line.)

d) Make a response plot for your final submodel, say P2. From Graph&Fit
select Plot of. Select P2:Eta’U for the H box and y for the V box. From
the OLS popup menu select Poisson and move the slider bar to 1. Move
the lowess slider bar until the lowess curve tracks the exponential curve well.
Include the response plot in Word.

e) Suppose that P1 contains your full model and P2 contains your final
submodel. Make an EE plot for your final submodel: from Graph&Fit select
Plot of. Select P1:Eta’U for the V box and P2:Eta’U, for the H box. After
the plot appears, click on the options popup menu. A window will appear.
Type y = x and click on OK. This action adds the identity line to the plot.
Also move the OLS slider bar to 1. Include the plot in Word.

f) Using c), d), e) and any additional output that you desire (eg AIC(full),
AIC(min) and AIC(final submodel), explain why your final submodel is good.

Warning: The following problems use data from the book’s web-
page. Save the data files on a disk. Get in Arc and use the menu com-
mands “File > Load” and a window with a Look in box will appear. Click
on the black triangle and then on 3 1/2 Floppy(A:). Then click twice on the
data set name.

11.6∗. a) This problem uses a data set from Myers, Montgomery and
Vining (2002). Activate popcorn.lsp in Arc with the menu commands
“File > Load > Floppy(A:) > popcorn.lsp.” Scroll up the screen to read the
data description. From Graph&Fit select Fit Poisson response. Use oil, temp
and time as the predictors and y as the response. From Graph&Fit select
Plot of. Select P1:Eta’U for the H box and y for the V box. From the OLS
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popup menu select Poisson and move the slider bar to 1. Move the lowess
slider bar until the lowess curve tracks the exponential curve. Include the
EY plot in Word.

b) From the P1 menu select Examine submodels, click on OK and include
the output in Word.

c) Test whether β1 = β2 = β3 = 0.
d) From the popcorn menu, select Transform and select y. Put 1/2 in the

p box and click on OK. From the popcorn menu, select Add a variate and type
yt = sqrt(y)*log(y) in the resulting window. Repeat three times adding the
variates oilt = sqrt(y)*oil, tempt = sqrt(y)*temp and timet = sqrt(y)*time.
From Graph&Fit select Fit linear LS and choose y1/2, oilt, tempt and timet
as the predictors, yt as the response and click on the Fit intercept box to
remove the check. Then click on OK. From Graph&Fit select Plot of. Select
L2:Fit-Values for the H box and yt for the V box. A plot should appear.
Click on the Options menu and type y = x to add the identity line. Include
the weighted fit response plot in Word.

e) From Graph&Fit select Plot of. Select L2:Fit-Values for the H box and
L2:Residuals for the V box. Include the weighted residual plot in Word.

f) For the plot in e), highlight the case in the upper right corner of the
plot by using the mouse to move the arrow just above and to the left the
case. Then hold the rightmost mouse button down and move the mouse to
the right and down. From the Case deletions menu select Delete selection
from data set, then from Graph&Fit select Fit Poisson response. Use oil,
temp and time as the predictors and y as the response. From Graph&Fit
select Plot of. Select P3:Eta’U for the H box and y for the V box. From
the OLS popup menu select Poisson and move the slider bar to 1. Move the
lowess slider bar until the lowess curve tracks the exponential curve. Include
the response plot in Word.

g) From the P3 menu select Examine submodels, click on OK and include
the output in Word.

h) Test whether β1 = β2 = β3 = 0.

i) From Graph&Fit select Fit linear LS. Make sure that y1/2, oilt, tempt
and timet are the predictors, yt is the response, and that the Fit intercept
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box does not have a check. Then click on OK From Graph&Fit select Plot
of. Select L4:Fit-Values for the H box and yt for the V box. A plot should
appear. Click on the Options menu and type y = x to add the identity line.
Include the weighted fit response plot in Word.

j) From Graph&Fit select Plot of. Select L4:Fit-Values for the H box and
L4:Residuals for the V box. Include the weighted residual plot in Word.

k) Is the deleted point influential? Explain briefly.

l) From Graph&Fit select Plot of. Select P3:Eta’U for the H box and
P3:Dev-Residuals for the V box. Include the deviance residual plot in Word.

m) Is the weighted residual plot from part j) a better lack of fit plot than
the deviance residual plot from part l)? Explain briefly.

R/Splus problems

Download functions with the command source(“A:/regpack.txt”).
See Preface or Section 17.1. Typing the name of the regpack function,
eg llressp, will display the code for the function. Use the args command, eg
args(llressp), to display the needed arguments for the function.

11.7. a) Obtain the function llrdata from regpack.txt. Enter the
commands

out <- llrdata()

x <- out$x

y <- out$y

b) Obtain the function llressp from regpack.txt. Enter the commands
llressp(x,y) and include the resulting plot in Word.

c) Obtain the function llrwtfrp from regpack.txt. Enter the com-
mands llrwtfrp(x,y) and include the resulting plot in Word.
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